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Chapter 7   Head, Probe and Sample 
Preparation

This chapter provides instructions for head, probe and sample preparation for imaging with the 
MultiMode SPM. It describes how to remove and install the microscope head, how to change the 
probe probe holder, how to mount the probe, load and position samples, and a general description 
of how to engage and withdraw the tip. These procedures are common for most types of MultiMode 
SPM imaging.

Please refer to the following sections:

• Initial Preparation for Contact AFM Imaging: Section 7.1

• Prepare the Sample: Section 7.1.1

• Load the Sample: Section 7.1.2

• Load Probe in Probe holder: Section 7.1.3

• Install the Probe holder: Section 7.1.4

• Laser Alignment: Section 7.2

• Method 1: OMV Method: Section 7.2.1

• Method 2: The Projection Method: Section 7.2.2

• Maximize the SUM Signal: Section 7.2.3

• Start the Microscope Program: Section 7.3

• Typical startup: Section 7.3.1

• Select Mode of Operation: Section 7.3.2

• Loading a saved workspace: Section 7.3.3

• MultiMode SPM Voltage Meters: Section 7.4
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Other chapters in this manual describe how to perform specific types of imagery. The table below 
outlines where you will find additional information for each type of imagery. If you are new to 
SPM and want to practice, we suggest you begin with Contact AFM in Chapter 9.

This instrument uses a semiconductor diode laser emitting a maximum 1.0mW beam at 690nm. 
The light is emitted downward and normally reflects back into the system’s optics from the back of 
the cantilever probe. Note that the laser is powered when the SPM head is plugged into the 
microscope’s support ring and the Mode switch is set to either AFM & LFM or TM AFM 
(tapping mode). Exceeding regulatory requirements, the MultiMode SPM head contains an internal 
switch which reduces laser power when the head is tilted. Operators should use care, however, to 
avoid staring into beams reflected from sample surfaces.

For Specific Information Regarding: See 
Chapter:

Contact AFM 9

Tapping Mode 10

Fluid Operation 11

Scanning Tunneling Microscopy (STM) 12

Lateral Force Microscopy (LFM) 13

Force Microscopy 14

Interleave Scanning 15

Magnetic Force Microscopy (MFM) 16

Electric Force Imaging 17
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WARNING: During and prior to set up of the laser, it is especially important to 
avoid looking directly at the laser beam or at the laser spot. Care 
should be taken when highly reflective samples are inserted onto 
the chuck. Avoid looking at all reflected laser light. Operators 
should use care to avoid staring into beams that may be reflected 
from sample surfaces.

AVERTISSEMENT:Avant d’utiliser le laser, et durant tout le temps pendant lequel il 
fonctionne, il est impératif de ne pas regarder directement le 
faisceau. Il est impératif de faire très attention lorsque des 
échantillons très réfléchissants sont déposés sur la platine. Eviter 
toute exposition à la lumière laser. Durant l’utilisation, ne pas fixer 
les faisceaux laser réfléchis par les surfaces d’échantillons.

WARNUNG: Es ist sehr wichtig, vor und während der Laserjustierung nicht in 
den Laserstrahl oder auf den Laserpunkt zu schauen. Seien Sie 
bitte sehr vorsichtig, wenn stark reflektierende Proben auf dem 
Probenteller liegen. Vermeiden Sie unter allen Umständen, in das 
reflektierte Laserlicht zu schauen. Alle Bediener des Mikroskops 
sollten größte Vorsicht walten lassen um zu vermeiden, in den von 
der Probenoberfläche reflektierten Laserstrahl zu schauen.
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7.1 Initial Preparation for Contact AFM Imaging

7.1.1 Prepare the Sample

Verify that your sample will fit atop the scanner tube and is less than 8mm thick. If you already 
have prior experience with loading samples into the MultiMode SPM system, load your sample 
now. Otherwise, read the next section for suggestions on how to prepare and load small samples.

If it is your first time operating the microscope, we recommend that you image the calibration 
sample provided with the instrument (usually a 10µm-pitch grid of 200nm step height).

1. The calibration sample or other small sample should be placed on one of the 15mm diameter 
metal disks used for sample mounting. The MultiMode SPM is provided with several steel 
sample disks that can be attached to the magnetic sample holder, located atop the scanner 
tube.

2. Provided with the instrument are red and white colored “sticky tabs,” which are 2-sided 
adhesive patches. Peel off a “sticky tab” from the provided sheet, and place it on the steel 
small sample puck, then peel off the red-and-white paper. This leaves a patch of the two-
sided adhesive on the steel sample disk, which will hold the sample to the disk. 

3. Using tweezers, place the small sample to be imaged firmly on the “sticky tab” adhesive 
(see Figure 7.1a). Alternatively, a small sample can be glued down to the sample puck using 
cyanoacrylate glue (superglue). 

4. Place the small sample disk atop the scanner.

Figure 7.1a   Gently Press the Sample onto the Sticky Tab Until Secured
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7.1.2 Load the Sample

Remove Head and Load Sample

1. Remove the head as required by unfastening the retaining springs on either side and 
unplugging the head’s micro-D connector.

2.  Gently lift the head off and set aside. This will expose the top of the scanner tube.

3. Mount the sample puck with the calibration standard on the scanner tube. An internal magnet 
holds the puck down.

Figure 7.1b   MultiMode Base with Scanner Mounted on Support Ring

Top of scanner tube.

Retaining springs

Place sample puck here.
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Reinstall the Head

• Adjust the sample height so that it will protrude no more than 2 mm above the head’s 
XY translation stage. If a probe holder is in the head and the sample is too high, the 
probe will be damaged when the head is installed. Adjust the sample height as needed 
by using the Tip Up/Down motor drive switch on the MultiMode base.

• Remount the head by gently lowering it over the scanner tube while checking for 
clearance.

• Secure both retaining springs and plug the head’s connector into the support ring
(see Figure 7.1c).

Figure 7.1c   Head is Held Securely Using Retaining Springs

Reattach retaining
springs (2)
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Check Head for Free Vertical Movement

Verify basic function of the motorized Z-axis by toggling the Up switch on the MultiMode base 
(see Figure 7.1d). This activates the leadscrew at the rear of the unit to lift the head upward. If you 
are using a standard, three-screw scanner, the two forward screws will also have to be rotated to 
keep the head level while lifting. (Single-screw, vertical scanners require only that the rear, 
motorized screw be rotated to raise and lower the head.) To verify rotation of the motorized screw, 
feel the flexible coupling on the base with your finger while you toggle the Tip Up / Down switch.

Figure 7.1d   Tip Up / Down Switch on the MultiMode SPM’s Base

7.1.3 Load Probe in Probe holder

• Contact Mode: Install a silicon nitride probe in the AFM probe holder. Figure 7.1e 
shows the AFM probe holder. Ensure the gold-plated side of the substrate is placed 
down toward the substrate mount, with the nitride film side attached to the cantilever 
oriented up away from the substrate mount.

• Tapping Mode: The procedure for single crystal silicon probes is essentially the same 
as for contact AFM (see above paragraph). The substrate should be face-up, with the 
probe’s cantilever pointing away from the AFM probe holder. This ensures that the 
cantilever and tip are facing toward the sample after the probe holder is mounted in the 
head.

Tip down

Tip up



Head, Probe and Sample Preparation
Initial Preparation for Contact AFM Imaging

102 MultiMode V8 - SPM Instruction Manual Rev. B

Figure 7.1e   Silicon Nitride Probe Installation

Figure 7.1f   Underside Detail of Fluid Cell

Apply gentle downward
pressure to lift spring clip.

Handle probes with tweezers.

Locate probe flush against
inside edges of groove.

Spring clip

(Underside of AFM probe holder)

Lift wire clip by pressing 
plunger on opposite side
of probe holder. Insert probe
with tweezers, then release
clip.

Wire clip
Probe
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Load Probe in Probe holder

Refer to Figure 7.1e and Figure 7.1f. Turn the probe holder upside down with the groove facing up 
as shown. Apply gentle upward pressure against the plunger to lift the spring clip. With the spring 
clip lifted, carefully slide the probe into the probe holder's groove until it is located squarely against 
the innermost edges, then lower the spring clip by releasing pressure against the plunger. This will 
hold the probe securely in the probe holder’s groove. Check that the probe's substrate is flush with 
the back of the groove and flat against one side (this keeps the probe's cantilever oriented in the 
correct direction). If identical probes are loaded the same way each time, aiming the laser onto the 
cantilever will be much quicker and easier. Fluid cell probe installation is similar to AFM/LFM 
probe holders.

7.1.4 Install the Probe holder

Figure 7.1g   Install Probe holder in Head without Touching the Sample

After the probe holder is loaded with a probe, the probe holder will be placed inside the SPM head 
and clamped into position using the clamping screw at rear of head.

CAUTION: The spring clip is extremely fragile and must be handled with great 
care to prevent bending.

ATTENTION: Les embouts de ressort sont extrêmement fragiles et doivent être 
manipulés avec une extrême précaution.

VORSICHT: Die Haltefeder ist sehr empfindlich und muß sehr vorsichtig 
behandelt werden, um ein Verbiegen zu vermeiden.

Clamping
screw(Rear

 View)

Rotate clamping screw

CW to secure Probe Holder
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1. Before installing the probe holder, verify that the head is sufficiently raised to clear the 
sample with the tip. The top of the sample should not protrude more than 1-2mm above the 
inside head bottom plate and is safer if set so the sample is flush with the plate. Excessive 
protrusion risks a crash between sample and tip when the probe holder is installed. 

2. Insert the loaded AFM probe holder into the MultiMode head by placing the probe holder 
carefully over the sample. Do not touch the sample with the probe holder. 

3. Press the probe holder forward gently and lower it into position (see Figure 7.1g).

Three precision ball mounts inside the head mate kinematically with the probe holder underside. If 
the scanner cap has been properly positioned, the probe holder will come to rest with the probe just 
above the sample surface. If the scanner cap is adjusted too high, the tip will be plunged into the 
sample surface and broken. If it appears the probe may crash when the probe holder is installed, 
remove the probe holder completely and use the Up switch on the MultiMode base to obtain 
sufficient clearance. Inexperienced users should practice with scrap probes and samples to learn 
proper loading procedures.

7.2 Laser Alignment

This section describes two methods for aligning the laser for all modes except STM. The first 
method uses an Optical Viewing Microscope (OMV). The OMV method requires that the sample 
be reflective. The second method is a “projection” method. In the projection method, you remove 
the MultiMode head and project the laser beam onto a surface (white paper or other suitable 
surface) to show a silhouette of the cantilever in order to align the laser. The projection method is 
used if you do not have an OMV or if your sample does not reflect the laser enough to be viewed in 
the OMV.



Head, Probe and Sample Preparation
Laser Alignment

Rev. B MultiMode V8 - SPM Instruction Manual 105

7.2.1 Method 1: OMV Method

Figure 7.2a   OMV System Components

1. Use the OMV to locate and focus on the cantilever.

2. Focus below the tip on the surface.

3. Bring the head/tip down using and the stepper motor and, if applicable, the front manual 
screws, until the cantilever is almost in focus.

4. While maintaining focus, use the OMV stage screws to locate the red laser reflection spot.

5. Use the manual laser knobs on top of the head to move the laser onto the end of the 
cantilever.

CAUTION: Turn down the illuminator intensity before proceeding with laser 
alignment.
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6. A quick way of checking laser alignment is to place a piece of paper in front of the 
photodetector to ensure the laser reflection is solid. (A small “post-it” note folded lengthwise 
works well).

Note: Because the slip of paper prevents light from reaching the photodetector, the 
sum signal cannot be monitored while using this method.

Figure 7.2b   Laser Alignment with Piece of Paper

7. Reposition the laser with the screws on top of the optical head, if necessary.

7.2.2 Method 2: The Projection Method

You can also align the laser by moving the laser beam relative to the cantilever while observing the 
laser spot on a piece of white paper below the optical head. If the laser is not on the cantilever 
substrate, the laser appears as a bright red spot on the surface below. When the laser is aligned on 
the cantilever, a shadow appears on the surface below.

The X direction runs along the major axis of the substrate (parallel to the length of the cantilever). 
The right-front laser control knob, atop the optical head, controls the laser beam movement along 
the X direction. The back-left laser knob, atop the optical head moves the beam along the Y 
direction perpendicular to the cantilever and substrate's major axis. In the vision system display, the 
X direction is right-to-left across the screen, and the Y direction is top-to-bottom.

The procedure for aligning the laser is slightly different for etched silicon and for silicon nitride 
probes. The sections below detail the procedures for aligning the laser on the cantilever and tips for 
each probe type. 

CAUTION: Turn down the illuminator intensity before proceeding with laser 
alignment.

Y

X
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Etched Silicon Probes (tapping mode)

1. In this procedure, shining the laser beam on a piece of white paper serves as a guide to 
aligning the laser beam with the end of the cantilever.

2. Verify the laser beam is visible on the surface below. If it is not, turn the front-right laser 
control knob counter-clockwise until the laser spot appears on the surface below.

3. Turn the front-right laser control knob clockwise to move the laser in the X positive direction 
(right) until the laser spot disappears from the surface below. Turn the front-right laser 
control knob counter-clockwise until the laser spot just reappears. The laser is now 
positioned at the edge of the substrate (see Point 1 in Figure 7.2c).

Figure 7.2c   Etched Silicon Tip Laser Alignment

4. Turn the back-left laser control knob clockwise or counter-clockwise to move the laser in the 
Y direction (parallel to the substrate edge and perpendicular to the cantilever) until the beam 
crosses the cantilever and a shadow appears over the laser spot on the surface below. Turning 
the back-left laser control know clockwise moves the laser beam back from the front of the 
MultiMode head. The laser is now positioned over the cantilever (see Point 2 in Figure 7.2c).

5. Verify that the laser is deflecting off the cantilever by moving the laser on, over, and off the 
cantilever by turning the back-left laser control knob less than 1/8 of a turn.

6. Turn the front-right laser control knob counter-clockwise to move the laser in the X negative 
direction on the cantilever until the laser crosses the tip-end of the cantilever and falls on the 
surface below.

7. Move the laser onto the tip-end of the cantilever by reversing the direction of the front-right 
laser control knob clockwise until the spot disappears from the surface below (see Point 3 in 
Figure 7.2c).

CAUTION: Use extreme caution if you choose to remove the optical head and 
hold it over a piece of paper. Hold the head firmly, and be mindful 
of the wire between the head and base. Dropping the optical head 
would most likely result in damage and could result in necessary 
factory repairs.
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8. Verify the laser spot by placing a piece of paper in front of the photodetector (see Section 
7.2.1, Step 6). If necessary, reposition the laser with the front-rear and back-left knobs.

Silicon Nitride Probes (Contact Mode AFM)

1. In this procedure, the laser is aligned by shining the laser beam on a piece of paper (or other 
projection surface) to show a silhouette of the cantilever.

2. If the laser beam is not visible on the projection surface, turn the front-right laser control 
knob counter-clockwise until the laser spot appears.

3. Turn the front-right laser control knob clockwise to move the laser in the X positive direction 
until the laser spot is blocked by the probe substrate and the projected beam disappears. Turn 
the right-rear laser control knob counter-clockwise until the laser spot just reappears. The 
laser is now positioned at the edge of the substrate (see Point 1 in Figure 7.2d).

Figure 7.2d   Silicon Nitride Laser Alignment

CAUTION: Use extreme caution if you choose to remove the optical head and 
hold it. Hold the head firmly and avoid damaging the wire between 
the head and base. Dropping the head is likely to result in damage 
which will require factory repair.

1
1
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4. With the laser positioned at the edge of the substrate, use the back-left laser control knob to 
move in the Y direction (parallel to the edge of the substrate) until the laser is positioned at 
the base of a desired cantilever. Ensure that the cantilever selected is appropriate for the 
analysis which is to be performed. In this example, we will assume that the cantilever at point 
2 is the desired one (see Point 2 in Figure 7.2d).

Note: It may be necessary to cross a maximum of four legs on the two V-shaped 
cantilevers to determine which is the correct cantilever. 

5. Adjust the back left and front right controls to move the laser beam position to the end of the 
cantilever (see Point 3 in Figure 7.2d) as seen in the projected silhouette.

6. When the beam is positioned at the point of the “V” of the cantilever, remount the head onto 
the scanner.

7. Verify laser alignment by placing a piece of paper (a small “post-it®” note folded lengthwise 
works well) into the head (ref Figure 7.2b).

7.2.3 Maximize the SUM Signal

This section describes what to do after the laser spot is aligned on the cantilever. It assumes you 
know how to read voltages from the meters mounted on the front of the MultiMode base. If you are 
unfamiliar with reading the MultiMode voltage meters, skip ahead to MultiMode SPM Voltage 
Meters: Section 7.4, then return to this section. Additional information is provided in each of the 
various chapters on imaging.

After the laser beam is aligned, move the mirror lever on the back of the head (Figure 7.2e) to 
maximize the SUM signal. Next, use the Photodetector Vertical Adjustment Knob (A-B) to set the 
output signal to the value required for the imaging mode (refer to specific chapters on imaging 
mode).
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Figure 7.2e   Photodetector Signals are Optimized using the Head’s Adjustments

This adjustment is much less sensitive than the laser position adjustments. The maximized sum 
signal should be approximately 4.0 - 9.0V for silicon nitride cantilevers. The value of this signal 
varies with many factors. It is important to note that it is possible to see a large response on the bar 
graph without having the laser beam on the cantilever, so it is important to visually verify that the 
laser beam is on the cantilever and not rely on the bar graph alone. Attempting to engage with the 
laser beam improperly aligned will usually destroy the cantilever and may damage the sample.

7.3 Start the Microscope Program

7.3.1 Typical startup

After any necessary software installation is complete, you are ready to start the NanoScope 
software.

Note: If the system has been previously set-up and the workspace saved, the previous 
settings can be reloaded as described in Section 7.3.3, otherwise, complete the 
procedure in this section.

1. To start the NanoScope software, double-click the NanoScope startup icon on the computer 
desktop.

2. This opens the NanoScope software window, shown in Figure 7.3a. This large window will 
contain all the areas and panels you use to control the microscope and analyze your results.

Photodetector adj. 

X-axis

Y-axis
Photodetector mirror lever

Photodetector adj.

Probe holder clamping screw

(Front-Top View)

(Rear View)

A-B signal

C-D signal
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Figure 7.3a   NanoScope Version 8 Screen Elements

3. Set the microscope configuration by selecting Tools > SELECT MICROSCOPE... from the 
menu bar. See Figure 7.3b.

Figure 7.3b   SELECT MICROSCOPE from the Tools menu

Menu Bar

Toolbar

Workflow
Toolbar

Status Bar

Browse Window
Real-time Status Window

Scan Parameters
List

Image Windows

Client WindowScope WindowsImage Thumbnails

Video Window
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4. This opens the Microscope Select window, shown in Figure 7.3c.

Figure 7.3c   Microscope Select Dialog Box

5. Click NEW if this is a new microscope, EDIT if you wish to modify a configured microscope, 
DELETE to remove a microscope configuration or CANCEL to exit.

6. NEW and EDIT open the NEW EQUIPMENT window, shown in Figure 7.3d.

Figure 7.3d   Select the appropriate microscope from the New Equipment window

7. Select MULTIMODE V from the drop down Microscope menu. This step is not necessary if 
the MultiMode has not been reconfigured since the last use.

8. If the microscope has been previously set-up and the desired setting saved in a workspace, 
those settings can be loaded from the saved file. Refer to Section 7.3.3.
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9. Click SCANNER to open the Scanner Select window shown in Figure 7.3e.

Figure 7.3e   Select your scanner.

10. Select the SCANNER and click OK. This returns you to the Microscope Select window, 
shown in Figure 7.3c.

11. Click OK to close the Equipment window.

12. Click OK to close the Microscope Select dialog box.
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7.3.2 Select Mode of Operation

1. Click EXPERIMENT > SELECT EXPERIMENT or the SELECT EXPERIMENT icon in the top 
left of the NanoScope software window. This opens the Select Experiment window, shown 
in Figure 7.3f.

Figure 7.3f   The Select Experiment, Contact Mode, window

2. Select the Experiment Category and Experiment.

3. Click START EXPERIMENT.
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7.3.3 Loading a saved workspace

1. Previously saved settings may be loaded by: File > Open and selecting the previously saved 
Experiment (*.wks) file.

Figure 7.3g   Open Workspace
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7.4 MultiMode SPM Voltage Meters

• A complete description of the signals coming into and out of the MultiMode SPM is 
available in Support Note 424, Signal Access Module V. The SAM is normally used for 
accessing these signals directly. A brief description of the SPM’s voltages and their 
interpretation using the meters on the front of the base is provided here for quick 
reference.

• The MultiMode SPM base is equipped with meters which indicate voltage coming from 
the four-segment photodetector. The photodetector array is represented in Figure 7.4a.

Figure 7.4a   Photodetector layout

Vertical deflection

Vertical deflection

Lateral deflectionLateral deflection

B

A

C D
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• The meters will display differently depending on which operating mode (see Figure 
7.4b) has been selected using the switch on the base. In addition, an LED indicator light 
will change color to red in contact mode and green in tapping mode. 

Figure 7.4b   Mode selector switch 

Red = Contact
Green = Tapping

Mode selector switch
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• In AFM & LFM (Contact) mode, the display will show values for VERT, HORZ and 
SUM. See Figure 7.4c.

Figure 7.4c   AFM & LFM mode meter display

• In TM AFM (Tapping) mode, the display will show values for RMS, VERT and SUM. 
See Figure 7.4d.

Figure 7.4d   TM AFM (Tapping) mode meter display.

• The MultiMode SPM’s SUM meter indicates the total voltage generated by the 
photodetector -- the combined voltage of photodetector segments. This is displayed 
during all modes (except STM when all meters are off).

•  VERT is the difference in voltages (A-B) between sections vertical halves of the 
photodetector. (In Tapping Mode it is the average difference).

• HORZ is the difference in voltages (C-D) between sections horizontal halves of the 
photodetector.

• RMS is the AC voltage resulting from the oscillation of the cantilever which causes the 
reflected beam to oscillate in the vertical direction.



Rev. B MultiMode V8 Instruction Manual 119

Chapter 8   ScanAsyst

This chapter covers procedures for operating the MultiMode Scanning Probe Microscope (SPM) 

using ScanAsystTM mode. It is assumed that the operator has previously prepared a ScanAsyst 
probe and aligned the laser per instructions provided in Chapter 7 of this manual. Specific 
information regarding tip preparation is also provided in Chapter 6.

• Introduction: Section 8.1

• ScanAsyst Principles of Operation: Section 8.2

• The “Heartbeat”: Section 8.2.1

• Force curves: Section 8.2.2

• Probe Selection: Section 8.3

• Basic ScanAsyst AFM Operation: Section 8.4

• Configure the Hardware: Section 8.4.1

• Adjust the Detector Offsets: Section 8.4.2

• Signal Settings: Section 8.4.3

• Adjust tip height above sample surface: Section 8.4.4

• Select the Microscope: Section 8.4.5

• Select Mode of Operation: Section 8.4.6

• Position Tip with OMV: Section 8.4.7

• Set Initial Scan Parameters: Section 8.4.8

• Image the sample: Section 8.4.9

• ScanAsyst and Peak Force Tapping Mode Parameters: Section 8.5

• Feedback Parameters: Section 8.5.1

• Peak Force Tapping Control Parameters: Section 8.5.2
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• Limits Parameters: Section 8.5.3

• Capture buttons: Section 8.6

• Optimizing a ScanAsyst image: Section 8.7

• Advanced Atomic Force Operation: Section 8.8

• Displaying Parameters: Section 8.8.1
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8.1 Introduction

ScanAsyst™ is the world’s first imaging mode with automatic image optimization technology for 
atomic force microscopy (AFM). This patent-pending innovation frees researchers from the task of 
adjusting scan parameters, such as setpoint, feedback gains, and scan rate. Intelligent algorithms 
continuously monitor image quality to make appropriate parameter adjustments. This makes 
imaging as easy as simply selecting a scan area and scan size for almost any sample in either air or 
fluid.

ScanAsyst is based on Bruker’s patent-pending, new general-purpose imaging mode, Peak Force 
Tapping™. This proprietary mode performs a very fast force curve at every pixel in the image. The 
peak force of each of these curves is then used as the imaging feedback signal. Unlike 
TappingMode™, where imaging force is a complex function of the setpoint and other variables, 
Peak Force Tapping provides direct force control. This allows it to operate at even lower forces than 
TappingMode, which helps protect delicate samples and tips. Together, these capabilities make 
ScanAsyst the most powerful and productive way to use AFM.

Peak Force Tapping mode modulates the MultiMode Z-piezo at ~2 kHz with a default Peak Force 
Amplitude of 150 nm (0-peak).

Because Peak Force Tapping mode does not resonate the cantilever, cantilever tuning is not 
required. This is particularly advantageous in fluids.

Peak Force Tapping mode includes auto-optimization (called ScanAsyst) of scanning parameters, 
including gains, setpoint and scan rate. This enables users to rapidly obtain high quality images. 
ScanAsyst is intended to be the first choice imaging mode for NanoScope version 8.10 and later 
software.

Because Peak Force Tapping mode controls the applied force, tip wear is reduced.

Peak Force Tapping mode imaging increases the resolution by controlling the force that the tip 
applies to the sample thereby decreasing the deformation depths; this decreases the contact area 
between the tip and sample. Because the deformation depths and lateral forces are small, there is 
minimal damage to the probe or sample.
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8.2 ScanAsyst Principles of Operation

Peak Force Tapping mode, the core technology behind the ScanAsyst mode, performs a very fast 
force curve at every pixel in the image. The peak of each of these force curves is then used as the 
imaging feedback signal. Peak Force Tapping mode modulates the MultiMode Z-piezo at ~2 kHz 
with a default Peak Force Amplitude of 150 nm (0-peak).

8.2.1 The “Heartbeat”

The Force vs. Time display, shown in Figure 8.2a is referred to as the “heartbeat.” The initial 
contact of the probe with the sample (B), peak force (C) and adhesion (D) points are labelled.

Figure 8.2a   The “heartbeat.”  Blue indicates approach while red indicates retract.
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8.2.2 Force curves

Using the Z-position information, the heartbeat is transformed into a force curve, shown in Figure 
8.2b.  The force curve plot is analyzed, on the fly, to produce the peak interaction force as the 
control feedback signal and the mechanical properties of the sample (Adhesion, Modulus, 
Deformation, Dissipation).

Figure 8.2b   Force curve

8.3 Probe Selection

Bruker recommends ScanAsyst probes for the ScanAsyst/Peak Force Tapping mode:

• ScanAsyst-Air (k ~ 0.4 N/m, tip radius < 10 nm)

• ScanAsyst-Fluid (k ~ 0.7 N/m, tip radius < 10 nm nominal, max. = 15 nm)

• ScanAsyst-Fluid+ (k ~ 0.7 N/m, tip radius < 20 nm nominal, max. = 60 nm) These 
probes have a SiNx coated tip.

You may purchase these probes from http://www.brukerafmprobes.com.
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8.4 Basic ScanAsyst AFM Operation

This section shows you how to perform a simple ScanAsyst experiment. Later sections will discuss 
Peak Force Tapping parameters and their influence on the measurements.

8.4.1 Configure the Hardware

1. Set the mode selector switch on the MultiMode base to AFM & LFM. See Figure 8.4a.

Figure 8.4a   Mode selector switch 

8.4.2 Adjust the Detector Offsets

Verify that the MultiMode head has been fitted with a ScanAsyst probe tip per instructions 
provided in Chapter 7 of this manual. The laser beam should already be positioned on the back of 
the cantilever. This will provide a starting point for adjusting the laser sum value.

To adjust the detector setting, first review the operation of the various adjustment screws (see 
Figure 8.4b). The detector adjustment screws are at the left side of the head.

Red = Contact
Green = Tapping

Mode selector switch
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Figure 8.4b   Photodetector Mirror Adjustments—Rear View

Refer to Figure 8.4c. For laser aligning screws atop the SPM head, the right-front screw moves the 
laser spot left-to-right (horizontally or along the X-axis). Turning this screw clockwise moves the 
laser spot to the right. The left-rear laser aligning screw moves the laser spot top-to-bottom 
(vertically along the Y-axis). Turning this screw clockwise moves the laser spot rearward.

Note: Use of the laser aligning screws to adjust the laser sum signal is NOT advised; 
users should adjust the laser sum signal from the photodetector adjustments 
only.

For initial adjustment, center the spot on the cantilever as described in Chapter 7.

Photodetector Vertical Adjustment Knob
(A - B)

Photodetector Horizontal Adjustment Knob
(C-D)

Tilt Mirror Lever
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Figure 8.4c   Laser Adjustment Knobs—Top View

8.4.3 Signal Settings

After aligning the laser, adjust the photodetector so the the Vertical Deflection and Horizontal 
Deflection are near 0V and the Sum is greater than approximately 5V.

Horizontal Adj.

V
e

rt
ic

al
.

Laser Spot
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8.4.4 Adjust tip height above sample surface

Next, use the adjustment screws to adjust the tip height to be just above the sample surface. The 
coarse adjustment screws on the scanner (if so equipped) are located in front and may be used to 
make gross adjustments. The tip should be positioned just high enough to reach the surface when 
engaged, but not so low as to risk crashing into it. Use the motorized screw to ensure the head is 
reasonably level. (This is not a problem on single-screw scanners.)

One method employed to adjust the height of silicon nitride tips on noncritical samples is to very 
slowly lower the tip using the adjustment screws until a sudden change is noted on the sum display 
of the MultiMode base. Most silicon nitride cantilevers are flexible and may be gently touched to 
the surface without damage to either the tip or the surface if the tip is lowered slowly. Watch for the 
change on the sum signal display! When the sum signal change is noted, stop lowering 
immediately. The Tip Up switch may then be toggled briefly to lift the tip just above the surface 
(the sum signal should resume its normal value). This method works well on samples which are not 
delicate and which can be imaged without concern for damage.

8.4.5 Select the Microscope

Follow the procedure described in Start the Microscope Program: Section 7.3.
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8.4.6 Select Mode of Operation

1. Click the SELECT EXPERIMENT icon. This opens the Select Experiment window, shown in 
Figure 8.4d.

Figure 8.4d   The ScanAsyst Select Experiment window

2. Select SCANASYST in the Choose an Experiment Catagory panel.

3. Select either SCANASYST IN AIR or SCANASYST IN FLUID in the Select Experiment Group 
panel.

4. Select either SCANASYST IN AIR or SCANASYST IN FLUID in the Select Experiment panel 
and click LOAD EXPERIMENT.
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5. This opens the Workflow Toolbar, the Scan One Channel window, the Force Monitor 
window and the Scan Parameters List window, shown in Figure 8.4e.

Figure 8.4e   ScanAsyst Mode in Air (Simple Mode) configuration

8.4.7 Position Tip with OMV

Focus the OMV on the sample, then raise the OMV focus until the sample is just out of focus. 
Lower the tip until it comes into focus. Refocus onto the sample surface and select Engage. 
Alternatively, focus on the sample surface and lower the tip until it begins to come into (but not 
quite) focus and then select ENGAGE.

Workflow Toolbar Scan One Channel WindowScan Parameter List Window

Force Monitor 

Window
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8.4.8 Set Initial Scan Parameters

Scan Panel

In the Scan panel of the Scan Parameters List, set the following initial scan parameters (see 
Figure 8.4f).

1. Set the Scan Size.

2. Set the Scan Angle.

Feedback Panel

1. Set ScanAsyst Auto Control to ON (see Figure 8.4f).

Figure 8.4f   ScanAsyst in Air (Simple Mode) Parameters Panel
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Channels 1, 2, 3 and 4

The default ScanAsyst channel settings are listed below:

1. Channel 1 Data Type is HEIGHT SENSOR (see Figure 8.4g).

2. Channel 2 Data Type is PEAK FORCE ERROR.

3. Channel 3 Data Type is INPHASE.

4. Channel 4 Data Type is QUADRATURE.

5. Set Data Scale to a reasonable value for the sample or click the AUTOSCALE icon after 
engaging.

Note: For example, for a 200nm step height calibration sample, a reasonable Data 
Scale setting is 300nm initially.

6. Set Line direction to either TRACE or RETRACE.

Figure 8.4g   Default Channel Settings
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8.4.9 Image the sample

1. If needed, right-click in the Force Monitor window and click UNDOCK. See Figure 8.4h. 
You may DOCK the undocked Force Monitor window by right-clicking in it and clicking 
DOCK.

Figure 8.4h   Undock the Force Monitor window
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2. Select one plot to be FORCE VS. TIME and the other to be FORCE VS. Z.

3. Once scanning, the Force Monitor window, shown in Figure 8.4i, should display a Force vs. 
Z plot and a “heartbeat” (Force vs. Time) plot.

Figure 8.4i   The Force Monitor window
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4. The HEIGHT channel in the Scan window, shown in Figure 8.4j, will display a topographical 
image of your sample. 

Figure 8.4j   Height Image of a PS + LPDE blend.
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8.5 ScanAsyst and Peak Force Tapping Mode Parameters

8.5.1 Feedback Parameters

Peak Force Setpoint

The setpoint for peak force. If the deflection sensitivity is calibrated, the force (in Newtons) will be 
displayed.

When the ScanAsyst Setup is ON, Peak Force Setpoint is automatically controlled by NanoScope 
software. Under some conditions, you may desire to control the Peak Force Setpoint manually. A 
Peak Force Setpoint that is too high can either damage the sample or wear the tip. It is generally 
desirable to reduce the Peak Force Setpoint to as small a value as possible. However, in order to 
achieve accurate Elastic modulus measurement, sufficient sample deformation is needed. If the 
deformation is less than 2nm, increase the Peak Force Setpoint to achieve sufficient sample 
deformation.

Note: When performing AUTO CONFIG operations with a small Peak Force Setpoint 
(less than ~20mV), the tip may drift out of contact with the surface and will be 
unable to return and track the surface. It is therefore recommended using a 
relatively large Peak Force Setpoint while performing AUTO CONFIG 
operations and reducing the Peak Force Setpoint later if necessary.

Feedback Gain

The gain of the Peak Force Tapping feedback control loop.

Note: Both Peak Force Setpoint and Feedback Gain are dynamically and 
automatically controlled when ScanAsyst Auto Control is set to ON.

Note: A Feedback Gain that is too large will cause oscillation of the system and 
increase noise, while too small a Feedback Gain will result in poor sample 
tracking.

Low Pass Deflection Bandwidth

The low pass filter is used to reduce deflection noise. Lower bandwidths will reduce noise but will 
distort the force curve and introduce errors in quantitative nanomechanical property measurements.

Range and Settings: 10 kHz - 65.56 kHz (Default value: 40 kHz).
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ScanAsyst Setup

Range and Settings: NEVER: Does not allow ScanAsyst Auto Control.

ALLOW: Allows ScanAsyst Auto Control.

Note: SHOW ALL, discussed in the NanoScope Software Version 8 User Guide, must 
be enabled to view and edit this parameter.

ScanAsyst Noise Threshold

ScanAsyst Noise Threshold is linked to the Feedback Gain and is used to tune it. Larger 
ScanAsyst Noise Thresholds will result in better sample tracking but increased oscillation noise. 
Lower ScanAsyst Noise Thresholds will result in a cleaner image but the sample tracking will 
suffer.

Range and Settings: 0.5 nm is appropriate for most samples while 1 nm is appropriate for rough 
samples and 0.05 nm may be appropriate for very flat samples.

Note:  When ScanAsyst Auto Z Limit control is turned ON, the ScanAsyst Noise 
Threshold parameter is automatically set by the program and cannot be 
changed.

ScanAsyst Auto Config Frames

At the end of every N frames, the probe is lifted by the Lift Height distance, the noise measured 
and then subtracted.

Range and Settings: 0 - 100. If ScanAsyst AutoConfig Frames = 0, background subtraction is not 
done.

ScanAsyst Auto Control

Range and Settings: OFF: Turns ScanAsyst Auto Control OFF.

ON: Turns ScanAsyst Auto Control ON.

INDIVIDUAL: Allows individual control of ScanAsyst Auto Gain, ScanAsyst 
Auto Setpoint, ScanAsyst Auto Scan Rate and ScanAsyst Auto Z Limit.

ScanAsyst Auto Gain

ScanAsyst Auto Gain allows NanoScope to dynamically control Feedback Gain.

Range and Settings: OFF: Turns ScanAsyst Auto Gain OFF.

ON: Turns ScanAsyst Auto Gain ON.
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ScanAsyst Auto Setpoint

ScanAsyst Auto Setpoint allows NanoScope to dynamically control the Peak Force Setpoint.

Range and Settings: OFF: Turns ScanAsyst Auto Setpoint OFF.

ON: Turns ScanAsyst Auto Setpoint ON.

Note: This option is very useful for users who want to change the Peak Force 
Setpoint manually to achieve adequate deformation on the sample while 
leaving ScanAsyst Auto Gain ON.

ScanAsyst Scan Auto Scan Rate

ScanAsyst Scan Auto Scan Rate allows NanoScope to control the Scan Rate.

Range and Settings: OFF: Turns ScanAsyst Scan Auto Scan Rate OFF.

ON: Turns ScanAsyst Scan Auto Scan Rate ON.

ScanAsyst Auto Z Limit

ScanAsyst Auto Z Limit allows NanoScope to control the Z Limit. The ScanAsyst Auto Z Limit 
function will detect if the surface is sufficiently smooth to allow reduction of the Z Limit and thus 
avoid bit noise in the Height and Height Sensor channel. This will be effective after a whole frame 
of the image is scanned. If the Z Limit needs to be reduced, the ScanAsyst Noise Threshold will 
automatically be reduced to 0.15 times the original ScanAsyst Noise Threshold to reduce the 
oscillation noise for smooth samples.

Range and Settings: OFF: Turns ScanAsyst Auto Z Limit OFF.

ON: Turns ScanAsyst Auto Z Limit ON.

8.5.2 Peak Force Tapping Control Parameters

Peak Force Amplitude

The zero-to-peak amplitude of the cantilever drive in the Z axis (Z modulation). Increasing Peak 
Force Amplitude will reduce the contact time during each tip tapping cycle on the sample and help 
tracking the rough and/or sticky sample by avoiding a situation where the tip is unable to pull off 
from the sample. Reduced Peak Force Amplitude is desired in liquid on flat samples. Less Peak 
Force Amplitude results in less hydrodynamic force disturbance.
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Lift Height

The distance that the Z-piezo is retracted from the sample during an AUTO CONFIG operation.

Note: Changing the Lift Height will automatically start the AUTO CONFIG function 
(see Optimizing a ScanAsyst image:  Page 142) and retract the Z piezo to the 
specified Lift Height. Clicking AUTO CONFIG will automatically calculate the 
Lift Height and perform an AUTO CONFIG operation.

8.5.3 Limits Parameters

Z Limit

Permits attenuation of maximum allowable Z voltage and vertical scan range to achieve higher 
resolution (smaller quantization) in the Z direction.

Range or Settings: 11 V (~0.1375 m) to 416 V (~5.2 m).

Note: SHOW ALL, discussed in the NanoScope Software Version 8 User Guide, must 
be enabled to view and edit this parameter.

Deflection Limit

Use this parameter to attenuate the maximum allowable deflection signal to achieve higher 
resolution. If this value is too small, saturation of the Deflection channel will occur.

Range or Settings: 4.096V - 24.58V.
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8.5.4 Parameter Visibility

The visibility of various parameters depends on the selected mode. Table 8.5a shows parameter 
visibility as a function of microscope mode.

Table 8.5a   Parameter Visibility

Panel Parameter Simple Mode Expanded Mode Show All Other Dependencies

F
ee

d
b

ac
k

Peak Force 
Setpoint

Yes Yes Yes

Feedback Gain Yes Yes Yes

Low Pass 
Deflection 
Bandwidth

No Yes Yes

ScanAsyst 
Setup

No No Yes

ScanAsyst 
Noise 

Threshold

No Yes Yes

ScanAsyst 
Auto Config 

Frames

Yes Yes Yes

ScanAsyst 
Auto Control

Yes Yes Yes

ScanAsyst 
Auto Gain

Yes Yes Yes ScanAsyst Auto Control

ScanAsyst 
Auto Setpoint

Yes Yes Yes ScanAsyst Auto Control

ScanAsyst 
Scan Auto 
Scan Rate

Yes Yes Yes ScanAsyst Auto Control

ScanAsyst 
Auto Z Limit

Yes Yes Yes ScanAsyst Auto Control

L
im

it
s Z Limit Yes Yes Yes

Deflection 
Limit

No Yes Yes
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8.6 Capture buttons

The capture buttons allow you to collect data for use with the NanoScope Analysis off-line analysis 
software.

1.  Start to collect a ScanAsyst/Peak Force Tapping image.

2. When you are in a region of interest, click the CAPTURE LINE button, shown in Figure 8.6a, 
to capture a scan line.

Figure 8.6a   CAPTURE LINE button
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3. The High Speed Data Capture window, shown in Figure 8.6b, will open and the Status will 
change when the data has been captured. UPLOAD DATA to the PC when the capture is 
complete. When CAPTURE LINE is used this way, the off-line NanoScope Analysis software 
will correctly associate the capture line of the high speed data capture with the line in the 
image.

Figure 8.6b   High speed data capture is complete. However, the data is not immediately transferred to the PC.

4. Click the UPLOAD DATA button to transfer the captured data to the computer. While the data 
transfer process takes place, the scan data will look corrupted because the DSP time is shared 
between PeakForce QNM properties computation and data transfer.
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8.7 Optimizing a ScanAsyst image

If your force curves show background noise or otherwise need improvement, click AUTO CONFIG 
to invoke the real-time pattern analysis algorithm that removes parasitic deflection.

Note: Clicking AUTO CONFIG will automatically calculate the Lift Height and 
perform an AUTO CONFIG operation.

Figure 8.7a   The AUTOCONFIG button
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8.8 Advanced Atomic Force Operation

8.8.1 Displaying Parameters

You can adjust the number of parameters shown in the Scan Parameter List using several 
methods.

Simple Mode

1. The default SIMPLE MODE, intended for novice users and shown in Figure 8.8a, displays the 
minimum number of parameters needed to make an image.

Figure 8.8a   The SIMPLE MODE view of the Scan Parameter List for ScanAsyst in Air
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Expanded Mode

1. The EXPANDED MODE view, shown in Figure 8.8b, increases the number of displayed 
parameters enabling expert users to fine tune an image.

Figure 8.8b   The EXPANDED MODE view of the Scan Parameter List for ScanAsyst in Air
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Show All

1. From the Menu bar, click EXPERIMENT > CONFIGURE EXPERIMENT. This opens an 
information window, shown in Figure 8.8c.

Figure 8.8c   The Configure Experiment information window

2. Click OK to open the Configure Experiment window, shown in Figure 8.8d.

Figure 8.8d   The Configure Experiment Window

3. Click CANCEL which will close the Configure Experiment window.
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4. Right-click in the Scan Parameter List panel and select SHOW ALL, shown in Figure 8.8e.

Figure 8.8e   Select SHOW ALL items
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This makes all Scan Parameters visible along with two check boxes, the left, green, check box for 
the SIMPLE MODE and the right, red, check box for the EXPANDED MODE. See Figure 8.8f.

Figure 8.8f   Enable Parameters

Without “”
Parameter will
not display

With “”
Parameter will
display
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The checked  parameters display in normal Real-time mode while those parameters without a  
will not display in normal Real-time mode.

Check the parameters that you want displayed and right-click in the Scan Parameter List and 
select SHOW ALL items to hide the unchecked parameters. The panel will once again appear in 
normal Real-time mode.


